Tivoli OMEGAMON II for IMS

Version 5.5.0

Application Trace Facility
# Contents

- **Figures** ................................................................. 7
- **Preface** ................................................................. 9
  - About This Guide .................................................. 10
  - Documentation Conventions ................................. 15
- **Chapter 1. Overview** ............................................ 17
  - What Is ATF? ....................................................... 18
  - ATF Components .................................................. 19
  - How ATF Works ..................................................... 20
- **Chapter 2. Before You Begin** ................................ 23
  - Operating Requirements ....................................... 24
  - ATF and Your System ........................................... 25
  - ATF Installation .................................................. 26
- **Chapter 3. Starting ATF** ........................................ 27
  - Starting the ATF Manager .................................... 28
  - Starting the IMS Monitor ...................................... 31
  - Starting a Classic OMEGAMON II ATF Session .......... 32
- **Chapter 4. ATF Actions** ......................................... 35
  - Managing Application Traces ................................. 36
  - ATF Actions .......................................................... 39
  - Setting the Cursor Option .................................... 41
- **Chapter 5. Administrative Functions** ..................... 43
  - Clearing a Dataspace ........................................... 44
  - Viewing the ATF Status ......................................... 45
- **Chapter 6. ATF Filtering** ....................................... 47
  - How to Use ATF Filtering ...................................... 48
  - ATF Usage Recommendations ................................. 49
- **Chapter 7. Transaction Data Displays** ..................... 51
  - Displaying ATF Data from OMEGAMON II ................. 52
  - Summary of Transaction Data ............................... 53
  - Trace Details ........................................................ 56
  - Event Timings ........................................................ 60
  - Trace Event List .................................................. 62
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ATF control and data flows</td>
<td>19</td>
</tr>
<tr>
<td>2</td>
<td>Multiple ATF sessions</td>
<td>20</td>
</tr>
<tr>
<td>3</td>
<td>OMEGAMON II Options pull-down</td>
<td>37</td>
</tr>
<tr>
<td>4</td>
<td>Application Trace Control panel</td>
<td>38</td>
</tr>
<tr>
<td>5</td>
<td>Controls panel</td>
<td>41</td>
</tr>
<tr>
<td>6</td>
<td>Application Trace Facility Status panel</td>
<td>45</td>
</tr>
<tr>
<td>7</td>
<td>ATF Transaction History panel</td>
<td>52</td>
</tr>
<tr>
<td>8</td>
<td>View pull-down</td>
<td>54</td>
</tr>
<tr>
<td>9</td>
<td>Filter Criteria for Lterm/Userid panel</td>
<td>55</td>
</tr>
<tr>
<td>10</td>
<td>ATF Transaction History panel</td>
<td>55</td>
</tr>
<tr>
<td>11</td>
<td>Trace History Details for DSPINV</td>
<td>56</td>
</tr>
<tr>
<td>12</td>
<td>Trace History Details for DSN8CS</td>
<td>57</td>
</tr>
<tr>
<td>13</td>
<td>Trace Event Timings for DSPINV</td>
<td>60</td>
</tr>
<tr>
<td>14</td>
<td>Trace Event Timings for DSN8CS</td>
<td>61</td>
</tr>
<tr>
<td>15</td>
<td>Application Trace for DSPINV</td>
<td>63</td>
</tr>
<tr>
<td>16</td>
<td>Application Trace for DSN8CS</td>
<td>64</td>
</tr>
</tbody>
</table>
This manual explains how ATF monitors and collects detailed information on IMS and DBCTL transactions to help you analyze and improve performance. This manual describes all of the information you require to use the Application Trace Facility of IBM® Tivoli® OMEGAMON II® for IMS.
About This Guide

Who should read this guide

Data center managers, performance analysts, capacity planners and database administrators will find useful information on monitoring IMS and DBCTL transactions in this manual. The IBM Tivoli OMEGAMON II for IMS Application Trace Facility, Version 5.5.0 manual explains how to define criteria to monitor IMS transactions, and describes how to use this information to improve system performance. This guide is for

Readers should be familiar with the following topics:

- Operating systems...
- Desktop environments...

Document set information

This section lists publications in the IBM Tivoli OMEGAMON XE for IMS on z/OS library and related documents. It also describes how to access Tivoli publications online and how to order Tivoli publications.

IBM Tivoli OMEGAMON XE for IMS on z/OS library

The following documents are available in the library:

- Getting Started with IBM Tivoli OMEGAMON XE for IMS on z/OS, SC32-9469
  Provides planning information for installing IBM Tivoli OMEGAMON XE for IMS on z/OS and information about the OMEGAMON XE zSeries® products.
- Configuring IBM Tivoli OMEGAMON XE for IMS on z/OS, SC32-9354
  Explains how to configure and customize IBM Tivoli OMEGAMON XE for IMS on z/OS and its user interfaces and components.
- Using IBM Tivoli OMEGAMON XE for IMS on z/OS, GC32-9351
  Describes the basics of using IBM Tivoli OMEGAMON XE for IMS on z/OS to manage real-time IMS environments.
- IBM Tivoli OMEGAMON XE for IMS on z/OS Release Notes, GI11-4037
  Contains information about what is new in this release, including new or revised OMEGAMON II® panels. Also contains information about problems discovered late in the testing cycle that are not included in the other publications and work-around procedures for those problems.

IBM Tivoli OMEGAMON II for IMS library

The following documents are available in the library:

- IBM Tivoli OMEGAMON II for IMS User’s Guide, GC32-9355
  Describes the basics of using IBM Tivoli OMEGAMON II for IMS to manage realtime IMS environments.
About This Guide

- **IBM Tivoli OMEGAMON II for IMS Configuration and Customization Guide, SC32-9356**
  Explains how to configure and customize OMEGAMON II and its user interfaces and components.

- **IBM Tivoli OMEGAMON II for IMS IMS Console Facility, SC32-9357**
  Provides a comprehensive description of the features of the IMS Console Facility (ICF) component.

- **IBM Tivoli OMEGAMON II for IMS Transaction Reporting Facility, SC32-9358**
  Provides user and reference information about the features of the Transaction Reporting Facility (TRF) component.

- **IBM Tivoli OMEGAMON II for IMS Bottleneck Analysis Reference Manual, SC32-9359**
  Provides reference information and descriptions of the features of the bottleneck analysis component.

- **IBM Tivoli OMEGAMON II for IMS Historical Component (EPILOG) Reference Manual, SC32-9360**
  Provides a comprehensive description of the features of the historical component (EPILOG®).

- **IBM Tivoli OMEGAMON II for IMS Historical Component (EPILOG) User’s Guide, GC32-9361**
  Teaches you, step-by-step, how to operate the historical component (EPILOG) reporter after installation.

- **IBM Tivoli OMEGAMON II for IMS Realtime Commands Reference Manual, SC32-9362**
  Describes in detail all of the features of the OMEGAMON II command interface.

- **IBM Tivoli OMEGAMON II for IMS Response Time Analysis (RTA) Reference Manual, SC32-9363**
  Provides reference information and descriptions of the features of the response time analysis (RTA) component.

- **IBM Tivoli OMEGAMON II for IMS Application Trace Facility, SC32-9470**
  Explains how the Application Trace Facility (ATF) monitors and collects detailed information on IMS and Database Control (DBCTL) transactions to help you analyze and improve performance.

- **IBM Tivoli End-to-End Response Time Feature Reference Manual, SC32-9376**
  Provides a description of the ETE Response Time feature and explains how to start ETE after installation and customization have been completed. Also includes a description of each ETE command argument and descriptions of the ETE error messages, return codes, and sense codes.
IBM Tivoli OMEGAMON Platform Messages

The following books document the messages issued by the OMEGAMON Platform components and products that run on it.

- IBM Tivoli Candle Products Messages Volume 1 (AOP–ETX), SC32-9416
- IBM Tivoli Candle Products Messages Volume 2 (EU–KLVGM), SC32-9417
- IBM Tivoli Candle Products Messages Volume 3 (KLVHS-KONCT), SC32-9418
- IBM Tivoli Candle Products Messages Volume 4 (KONCV-OC), SC32-9419
- IBM Tivoli Candle Products Messages Volume 5 (ODC–VEB and Appendixes), SC32-9420

Related publications

To use the information in this guide effectively, you must have some prerequisite knowledge, which you can obtain from the following guides:

- Installing and Setting up OMEGAMON Platform and CandleNet Portal on Windows and UNIX, SC32-1768
  Provides information on installing and setting up the component products of the OMEGAMON Platform: Candle Management Server®, CandleNet Portal, Candle Management Workstation®, Warehouse Proxy, Alert Adapter for AF/REMOTE®, Alert Adapter for Tivoli Enterprise Console®, and Alert Emitter for Tivoli Enterprise Console on Windows® and UNIX®.

- Administering OMEGAMON Products: CandleNet Portal, GC32-9180
  This document describes the support tasks and functions required for the OMEGAMON platform, including CandleNet Portal user administration.

- Using OMEGAMON Products: CandleNet Portal, GC32-9182
  This guide describes the features of CandleNet Portal and how best to use them with your OMEGAMON products.

- Historical Data Collection Guide for IBM Tivoli OMEGAMON XE Products, GC32-9429
  Describes the process of collecting historical data and either warehousing it or converting it to delimited flat files for reporting purposes. Also describes how to configure historical data collection and warehousing intervals using the CandleNet Portal describes how to maintain the Persistent Data Store used to collect and store historical data on z/OS.

- Configuring IBM Tivoli Candle Management Server on z/OS, GC32-9414
  Provides instructions for configuring and customizing the Candle Management Server on z/OS.

The online glossary for the CandleNet Portal includes definitions for many of the technical terms related to OMEGAMON XE software.

Accessing publications online
The documentation CD contains the publications that are in the product library. The format of the publications is PDF. Refer to the readme file on the CD for instructions on how to access the documentation.

IBM posts publications for this and all other Tivoli products, as they become available and whenever they are updated, to the Tivoli software information center Web site. Access the Tivoli software information center by first going to the Tivoli software library at the following Web address:

http://www.ibm.com/software/tivoli/library

Scroll down and click the Product manuals link. In the Tivoli Technical Product Documents Alphabetical Listing window, click the Tivoli OMEGAMON XE for IMS link to access the product library at the Tivoli software information center.

If you print PDF documents on other than letter-sized paper, set the option in the File -> Print window that allows Adobe Reader to print letter-sized pages on your local paper.

**Ordering publications**

You can order many Tivoli publications online at the following Web site:


You can also order by telephone by calling one of these numbers:

- In the United States: 800-879-2755
- In Canada: 800-426-4968

In other countries, contact your software account representative to order Tivoli publications.

**Tivoli technical training**

For Tivoli technical training information, refer to the following IBM Tivoli Education Web site:

http://www.ibm.com/software/tivoli/education

**Support information**

If you have a problem with your IBM software, you want to resolve it quickly. IBM provides the following ways for you to obtain the support you need:

- Searching knowledge bases: You can search across a large collection of known problems and workarounds, Technotes, and other information.
- Obtaining fixes: You can locate the latest fixes that are already available for your product.
- Contacting IBM Software Support: If you still cannot solve your problem, and you need to work with someone from IBM, you can use a variety of ways to contact IBM Software Support.

For more information about these three ways of resolving problems, see “Support Information” on page 65.
About This Guide

Participating in newsgroups

User groups provide software professionals with a forum for communicating ideas, technical expertise, and experiences related to the product. They are located on the Internet and are available using standard news reader programs. These groups are primarily intended for user-to-user communication and are not a replacement for formal support.

To access a newsgroup, use the instructions appropriate for your browser.
Documentation Conventions

Overview
This guide uses several conventions for special terms and actions, and operating system-dependent commands and paths.

Panels and figures
The panels and figures in this document are representations. Actual product panels may differ.

Required blanks
The slashed-b (§) character in examples represents a required blank. The following example illustrates the location of two required blanks.

§eBA*ServiceMonitor§0990221161551000

Revision bars
Revision bars (|) may appear in the left margin to identify new or updated material.

Variables and literals
In examples of z/OS® command syntax, uppercase letters are actual values (literals) that the user should type; lowercase letters are used for variables that represent data supplied by the user. Default values are underscored.

LOGON APPLID (cccccccc)
In the above example, you type LOGON APPLID followed by an application identifier (represented by cccccc) within parentheses.

Symbols
The following symbols may appear in command syntax:

Table 1. Symbols in Command Syntax

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The “or” symbol is used to denote a choice. Either the argument on the left or the argument on the right may be used. Example: YES</td>
</tr>
<tr>
<td></td>
<td>Denotes optional arguments. Those arguments not enclosed in square brackets are required. Example: APPLDEST DEST [ALTDEST] In this example, DEST is a required argument and ALTDEST is optional.</td>
</tr>
</tbody>
</table>
Some documents use braces to denote required arguments, or to group arguments for clarity. Example:

```
COMPARE {workload} -
   REPORT={SUMMARY | HISTOGRAM}
```

The `workload` variable is required. The REPORT keyword must be specified with a value of SUMMARY or HISTOGRAM.

Default values are underscored. Example:

```
COPY infile outfile - [COMPRESS={YES | NO}]
```

In this example, the COMPRESS keyword is optional. If specified, the only valid values are YES or NO. If omitted, the default is YES.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Usage</th>
</tr>
</thead>
</table>
| `{ }`  | Some documents use braces to denote required arguments, or to group arguments for clarity. Example:  
   ```
   COMPARE {workload} -
   \   REPORT={SUMMARY | HISTOGRAM}
   ```  
   The `workload` variable is required. The REPORT keyword must be specified with a value of SUMMARY or HISTOGRAM. |
| `_`    | Default values are underscored. Example:  
   ```
   COPY infile outfile - [COMPRESS={YES | NO}]
   ```  
   In this example, the COMPRESS keyword is optional. If specified, the only valid values are YES or NO. If omitted, the default is YES. |
Chapter overview

This chapter explains the purpose of the Application Trace Facility (ATF), and describes how you can use it to improve performance.

Chapter contents

What Is ATF? ................................................................. 18
ATF Components ....................................................... 19
How ATF Works ......................................................... 20
What Is ATF?

Overview

Application Trace Facility (ATF) is a component of IBM Tivoli OMEGAMON II for IMS, Version 5.5.0. ATF collects detailed performance data about events of one or more IMS and DBCTL transactions as they execute. This data is stored in a dataspace for you to review with the CUA.

Purpose

You can use the performance data ATF collects to:

- Identify transaction response-time components
- Fine-tune applications
- Understand how application programs operate

Role in OMEGAMON II

As part of OMEGAMON II, ATF information complements the summary level data collected by the Transaction Reporting Facility (TRF), another monitoring component of OMEGAMON II. Whereas TRF collects data such as CPU time, virtual storage use and response time, ATF collects data on:

- External subsystem activity, such as DB2 processing
- BMP scheduling and termination
- MPP scheduling and termination
- Regions
- DL/I DB calls
- IMS TM calls
- Message queue manager calls
ATF Components

Overview

The main components of ATF are:

- ATF Manager
- ATF Collector

The ATF Manager controls the collection of IMS transaction data and routes this data to the ATF Collector. The ATF Collector packages this data for display on an ATF CUA panel. The collected data is stored in an MVS dataspace where it can be retrieved and displayed by the CUA interface panels. The level of trace data that is collected and displayed by ATF is at the IMS Monitor level. Figure 1 on page 19 shows the ATF control and data flows. The solid arrows indicate the control flow and the broken arrows indicate the flow of data.

Figure 1. ATF control and data flows
How ATF Works

Overview

ATF is a menu option you can select in IBM Tivoli OMEGAMON II for IMS. You define the type of information you want to collect in an ATF trace.

The amount of time and the type of data that ATF collects, depends on the criteria specified in ATF filter traces. Depending on the performance data you want to trace, you can activate and inactivate traces during an ATF session and modify the filter criteria.

The dataspace that stores the trace data is created at the same time the ATF session in the OMEGAMON CLASSIC address space is started. At the beginning of a new ATF session, the dataspace is cleared.

Refer to “ATF Actions” on page 35 for more information on adding and modifying traces and filter criteria.

Multiple ATF sessions

There is a one-to-one relationship between an IBM Tivoli OMEGAMON II for IMS and an ATF session. Multiple ATF sessions can monitor a single IMS system. Each OMEGAMON ATF session is identified by a unique job name. An IMS monitor can run concurrently with one or more ATF sessions. See Figure 2 on page 20.

Figure 2. Multiple ATF sessions

Displaying ATF data

The dataspace that stores the transaction data is an MVS dataspace with a default size of 65 megabytes. There is one ATF dataspace per OMEGAMON II address space, and its...
size is defined at startup. You can have several IBM Tivoli OMEGAMON II for IMS address spaces monitoring the same sub-system. Each of these address spaces can have one dataspace sized as needed.

You can view transaction data collected by ATF on the ATF Transaction History panel. From here, you can select individual transactions for more information. Refer to “Transaction Data Displays” on page 51 for examples of these data panels.
How ATF Works
Before You Begin

Chapter overview

ATF has a few requirements you should be aware of before you begin using it.

Chapter contents

Operating Requirements ......................................................... 24
ATF and Your System .......................................................... 25
ATF Installation ................................................................. 26
Operating Requirements

System requirements
ATF requires the CUA component of IBM Tivoli OMEGAMON II for IMS, Version 5.5.0.

*Note:* There is no OMEGAMON Classic Command Interface for ATF.

Environments
ATF supports the following environments:

- IMS DB/DC
- IMS DC
- IMS DBCTL

It also reports on any external subsystem whose interface uses the IMS SLOG function.
ATF and Your System

Impact on system performance

- ATF’s impact on the performance of your IMS and DBCTL system is the same as running the IMS Monitoring Facility.
- All address spaces must be executed as MVS systems started tasks.

Using ATF in a shared queue environment

ATF collects program performance data relative to a single IMS system. If an IMS executes in a shared queues environment with multiple IMS environments that can process the same transaction, the performance data provided by ATF will not be valid.

ATF executing in a shared queues environment with only one IMS environment provides the same performance data as if the single IMS were not in a shared queues environment.
Requirements

Installation requirements for ATF are:

- The mandatory use of IBM Tivoli OMEGAMON II for IMS's version of the IMS command security exit, DFSCCMD0.
- The placement of a load module dataset name in the IMS control regions STEPLIB concatenation. It should be placed before the IMS.RESLIB.
- The linking of the IMS Callable Services interface module with specific IBM Tivoli OMEGAMON II for IMS modules.

Security

ATF does not require any special RACF and/or IMS security. The security actions required are:

- Authorization of the DFSCCMD0 exit through IMS and DBCTL startup parameters
- Security authorization for IMS START/STOP commands for the IMS WTOR, master terminal and TCO environments
- For IMS and DBCTL systems, authorization of the same IMS commands through the E-MCS facility
Chapter overview

This section contains the startup and shutdown processes for the ATF Manager, a classic OMEGAMON II ATF session, and the IMS Monitor. An OMEGAMON II ATF session must be started to perform ATF activities such as setting up filters and traces. See “Managing Application Traces” on page 36 for details.

Chapter contents

Starting the ATF Manager ................................................................. 28
Starting the IMS Monitor ................................................................. 31
Starting a Classic OMEGAMON II ATF Session ............................... 32
Starting the ATF Manager

Introduction
To start ATF, issue a command in IMS to start the ATF Manager. The syntax of this command is shown under the topic, “Startup command” on page 29.

The commands to start and stop the ATF Manager are limited to the following terminals:
- Outstanding WTOR - LTERM WTOR
- Master terminal
- Time control option (TCO)

When you issue the ATF IMS start and stop commands, IMS messages are issued when they are completed successfully. These messages are generally considered error messages, but, in regards to ATF, are normal and should not be taken as errors.

When you issue the start and stop commands from a WTOR terminal in an IMS DB/DC and IMS DC environment, the following message is displayed when either of these commands is completed successfully:

**DFS3662W hh:mm:ss COMMAND REJECTED BY IMS SECURITY CHECK; RC=3272**

When you issue the ATF IMS start and stop commands from an MCS or EMCS console in an IMS DB/DC, IMS DC or DB Control environment, the following message is displayed when either of these commands is completed successfully:

**DFS093 COMMAND NOT AUTORIZED AS ENTERED WITH CRC FROM MCS OR E-MCS + CONSOLE**

It is also possible to receive the following IMS message when either command is completed successfully:

**DFS4445I CMD FROM MCS/E-MCS CONSOLE USERID=xxxxx: STA ATF**

*Note: If the start or stop command is issued from an unsupported terminal, a DFS107 message is displayed.*

ATF Manager and IMS

Starting and stopping the ATF Manager does not require that your IMS system also be started and stopped. It also has no impact on your IMS system.

An IBM Tivoli OMEGAMON II for IMS address space does not need to be simultaneously running to bring up the ATF Manager. However, a request to start an ATF session in the IBM Tivoli OMEGAMON II for IMS address space cannot be completed unless the ATF Manager is started. ATF will not begin to capture data until you define one or more traces with optional filter criteria.

In summary, starting ATF is performed in three steps:

1. Start the ATF Manager in IMS.
2. Ensure that an ATF session in the OMEGAMON for IMS address space has been started.

3. Define traces with or without filters using the CUA interface of IBM Tivoli OMEGAMON II for IMS.

Refer to the IBM Tivoli OMEGAMON II for IMS Configuration and Customization Guide, Version 5.5.0 for information to set up CICAT parameters for ATF.

### Startup command

The command to start the ATF Manager is:

```
/STA OIATFMON | ATF keyword=parameter,keyword=parameter
```

This command can be entered with a space instead of the equal sign (=) between the keywords and their respective values.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Values</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATFNUM</td>
<td>n, where n=1-32</td>
<td>1</td>
<td>The number of additional ATF sessions that can monitor a single IMS. The default is one OMEGAMON II ATF session.</td>
</tr>
<tr>
<td>ATFDCM</td>
<td>ON/OFF</td>
<td>ON</td>
<td>When ON, the IMS DC Monitor can gather data concurrently when one or more OMEGAMON II ATF sessions are running. ATFDCM and ATFDBM are mutually exclusive. For example, this parameter is not used within an IMS DBCTL system.</td>
</tr>
<tr>
<td>ATFDBM</td>
<td>ON/OFF</td>
<td>ON</td>
<td>When ON, the IMS DB Control Monitor can gather data concurrently when one or more OMEGAMON II ATF sessions are running. ATFDCM and ATFDBM are mutually exclusive. For example, this parameter is not used within an IMS DB/DC or an IMS DC system.</td>
</tr>
<tr>
<td>ATFDBDC</td>
<td>YES/NO</td>
<td>NO</td>
<td>When YES, the ATF Manager collects data for the DBCTL connections in an IMS DB/DC environment. When NO, then no DBCTL connections are monitored.</td>
</tr>
<tr>
<td>ATFTRAC</td>
<td>ON/OFF</td>
<td>OFF</td>
<td>When ON, ATF modules write to a file containing the ATF internal trace records that are generated by ATF modules. This should only be done at the request of IBM Software Support.</td>
</tr>
</tbody>
</table>
Starting the ATF Manager

Shutdown command

The command to shutdown the ATF Manager is:

/STO OIATFMON | ATF

When this command is issued, all active OMEGAMON II ATF sessions are terminated.
Starting the IMS Monitor

Introduction

You can start the IMS Monitor before or after the ATF Manager is started. Either way, the IMS Monitor collects data based upon your startup parameters.

The commands to start and stop the IMS Monitor are limited to the following terminals:

- Outstanding WTOR - LTERM WTOR
- Master terminal
- Time control option (TCO)

If an ATF IMS /TRA command is issued from an unsupported terminal, it will not be captured by the ATF Manager. This may cause the corruption of data passed to a concurrent IMS Monitor Facility.

When you issue the IMS /TRA commands, IMS messages are issued when they are completed successfully. These messages are generally considered error messages, but, in regards to ATF, are normal and should not be taken as errors.

When you issue the /TRA commands from a WTOR terminal in an IMS DB/DC and IMS DC environment, the following message is displayed when either of these commands is completed successfully:

**DFS3662W hh:mm:ss COMMAND REJECTED BY IMS SECURITY CHECK; RC=3272**

When you issue the /TRA commands from an MCS or EMCS console in an IMS DB/DC, IMS DC or DB Control environment, the following message is displayed when either of these commands is completed successfully:

**DFS093 COMMAND NOT AUTORIZED AS ENTERED WITH CRC FROM MCS OR E-MCS + CONSOLE**

It is also possible to receive the following IMS message when either command is completed successfully:

**DFS4445I CMD FROM MCS/E-MCS CONSOLE USERID=xxxxx: STA ATF**

Startup command

The command to start the IMS Monitor is:

```
/TRA SET ON MONITOR ALL
```

For details of this command, refer to the appropriate IMS operator’s reference manual.

Shutdown command

The command to shutdown the IMS Monitor is:

```
/TRA SET OFF MONITOR
```

For details of this command, refer to the appropriate IMS operator’s reference manual.
Starting a Classic OMEGAMON II ATF Session

Classic startup command

To start a classic OMEGAMON II ATF session, issue a START ATF command. This command creates the dataspace that holds the data captured by the ATF session.

During CICAT configuration, the member KI2ATFmp is created in rhilev.RKANPAR. It contains the START ATF command, with default values for the keywords TDUR and SIZE. You can edit the command to contain the values appropriate for your installation. See the topic Syntax below for definitions of these keywords and their defaults.

You issue the START ATF command through the MVS MODIFY command using the IBM Tivoli OMEGAMON II for IMS address space ID. The following is an example of the MVS MODIFY command:

f mpimsid,EXEC KI2ATFmp

where:

mp is the two-character MPREFIX set during installation.
imsid is the IMS ID specified in the startup PROC.

See the IBM Tivoli OMEGAMON II for IMS Configuration and Customization Guide for information on the MODIFY command.

Syntax

The syntax of the START command is:

START ATF,keyword=parameter,keyword=parameter,

Keyword | Values | Default | Description
--- | --- | --- | ---
ATFACT | ON|OFF | OFF | Activates/inactivates ATF. If OFF, the OMEGAMON II’s dataspace is not created and all the other keywords are ignored.
TDUR= | nnn, where nnn=1-999 | 5 | The number of minutes that an application trace is left to execute if a duration is not provided in a filter definition.
SIZE= | nnn | 65 | The size, in megabytes, of an OMEGAMON II’s dataspace holding the collected ATF trace data.

Shutdown command

To end the current ATF session, issue the following command by using the MVS modify command for the IBM Tivoli OMEGAMON II for IMS address space:

START ATF, ATFACT=OFF
The OMEGAMON II ATF session is terminated and the respective dataspace is deleted.
Starting a Classic OMEGAMON II ATF Session
Chapter overview

This chapter explains how to add, modify, delete, activate and inactivate transaction traces. It also describes the Application Trace Control panel, which displays the traces for an ATF session.

Chapter contents

Managing Application Traces .............................................................. 36
ATF Actions ....................................................................................... 39
Setting the Cursor Option ................................................................. 41
Managing Application Traces

Overview

You can add a trace and set filters by selecting the option, **Application Trace Facility**, on the Options pull-down from any IBM Tivoli OMEGAMON II for IMS panel. To view the data collected by ATF, see “Displaying ATF Data from OMEGAMON II” on page 52 for more information.

Trace filter editing

IMS resources are automatically edited for correctness when you add or modify trace filters. There are two types of editing:

- Specific checking of defined resources, transactions, PSBs and database names
- Checking and then warning as to proceed

There are instances where a transaction may not be predefined, for example, when receiving transactions using an APPC entry path. In this case, editing cannot be successful. Either a wild card format must be used in this filter, or another more restrictive filter criteria should be used.

Options pull-down

To perform tracing functions, you need to display the Application Trace Control panel. There are two ways to do this:

- **Type** `oa` in the input area of the action bar of an OMEGAMON II screen and press Enter.

  or

- **Select the option, Application Trace Facility**, from the OMEGAMON II Options pull-down.
The Application Trace Control displays the status of your ATF session and all of the traces for the session. The OMEGAMON II IMS Classic address space ATF session shown below was started with the command:

```
start atf,atfact=on,tdur=66,size=130
```
From this panel you can select options to:

- Add, modify or delete a trace
- Change the status of a trace
- Clear trace data
- Type an IMS command
ATF Actions

Overview
To collect application transaction data in an IMS environment, you can add, modify and delete traces for an ATF session. You can also inactivate a trace, and clear the contents of the dataspace. For the steps to clear trace data, refer to “Clearing a Dataspace” on page 44.

Selecting an ATF action
To select an ATF action on the Application Trace Control panel, you can either:

- Type the action in the command column for the trace (for example, type M to modify a trace).

or

- Select an option on the Actions pull-down.

Add a trace

1. On the Application Trace Control panel, type a in the command area of the Owner column. Or, type 2 on the Actions pull-down.

2. The Add Trace panel is displayed.

   Note: The Start Time and Date are set to the current time and date when this panel displays. The filter criteria is also preset. Type over this information only if you want to change it.

3. Type the number of minutes for the Duration (the length of time for which the trace collects data).

4. Specify the filter criteria for this trace:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tran</td>
<td>The name of the transaction to be traced (not valid when monitoring a DBCTL system)</td>
</tr>
<tr>
<td>Userid</td>
<td>The user ID that initiates the transaction, which in IMS/ETO systems, is usually synonymous with the logical terminal</td>
</tr>
<tr>
<td>Lterm</td>
<td>The logical terminal that initiates the transaction, which in IMS/ETO systems, is usually synonymous with the user ID (not valid when monitoring a DBCTL system)</td>
</tr>
<tr>
<td>Region ID</td>
<td>The IMS region ID</td>
</tr>
</tbody>
</table>
**ATF Actions**

### Modify a trace

**Note:** You must be the owner of a trace or have administrator authority to modify it.

1. On the Application Trace Control panel, type `m` in the selection column next to the trace you want to change. Or, type “/” in the selection column for the trace and then type 4 on the Actions pull-down.

2. On the Modify a Trace panel, type over values in the fields you want to change and then press Enter.

### Delete a trace

**Note:** You must be the owner of a trace or have administrator authority to delete it.

1. On the Application Trace Control panel, type `d` in the selection column next to the trace you want to delete. Or, type “/” in the selection column for the trace and then type 3 on the Actions pull-down.

2. The Delete Confirmation panel is displayed next. Type 1 to delete the trace.

### Activate/Inactivate a trace

When you activate a trace, it is turned on. When you inactivate a trace, the trace is immediately terminated. The trace criteria is saved for future use, but you should use caution when inactivating a trace. A warning message will prompt you to confirm this action.

**Note:** You must be the owner of a trace or have administrator authority to change its status.

1. On the Application Trace Control panel, type `i` in the selection column next to the trace to inactivate. Or, type “/” in the selection column for the trace and then type 5 on the Actions pull-down.

2. If you want to activate an inactive trace, type `i` in the selection column next to the trace. Or, type “/” in the selection column for the trace and then type 5 on the Actions pull-down.

### Enter an IMS command

You can perform other IMS functions while you are still in ATF.

1. Type 1 on the Actions pull-down.

2. Type the IMS command you want to perform (for example, `/STA PGM`).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSB</td>
<td>The name of the application program where this transaction is located</td>
</tr>
<tr>
<td>DB Data</td>
<td>The DB name, DEDB name, or an HALDB partition name (only valid for IMS V7.1 or higher)</td>
</tr>
</tbody>
</table>
Setting the Cursor Option

Overview

Several of the ATF panels have push buttons to display trace details, event timings and a list of events for a transaction. You can easily tab from one push button to the next because of a default setting in your Userid profile.

If this setting is changed and you can no longer tab from one push button to the next, you can reset the cursor option from the Options pull-down.

1. Select Options on any ATF panel to display the Options pull-down.
2. Select option 2, Set controls.
3. On the Controls panel, set the Position of cursor to D.

Figure 5. Controls panel
Chapter overview

ATF administrative functions give you the ability to clear a dataspace and to view the status of every ATF session running against a single IMS environment.

Chapter contents

Clearing a Dataspace ......................................................... 44
Viewing the ATF Status. .................................................... 45
Clearing a Dataspace

What is a dataspace?
A dataspace contains the collected trace data. Its size is defined when a OMEGAMON II ATF session is started (see “Starting a Classic OMEGAMON II ATF Session” on page 32).

Clearing a dataspace
Clearing a dataspace invalidates any trace data from that point forward. Use caution when performing this action.

Note: You must have administrator authority to clear a dataspace.

You can clear a dataspace at any time. When a dataspace is full, the following message is displayed:

Application Trace is out of space and is no longer collecting data

1. Display the Actions pull-down on the Application Trace Facility panel.
2. Select option 6, Clear Trace Data. The Confirm Request panel is displayed.
3. Select option 2, Clear trace data, and press Enter. The dataspace is cleared.
Viewing the ATF Status

Overview

You can view the status of the ATF Manager and a listing of all of the ATF sessions running against a single IMS environment on the Application Trace Facility Status panel.

Application Trace Facility Status panel

Press F16=ATF Status from any ATF panel where this key is listed to view the Application Trace Facility Status.

Figure 6. Application Trace Facility Status panel

<table>
<thead>
<tr>
<th>Actions</th>
<th>GoTo</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

KI2PTAST Application Trace Facility Status I61R

IMS Environment: DB/DC UTC Time Offset: -8

ATF Manager Connection Settings

+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+
<table>
<thead>
<tr>
<th>ATFACT</th>
<th>ATFNUM</th>
<th>AFTDCM</th>
<th>ATFDBM</th>
<th>ACTDBDC</th>
<th>AFTRAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON</td>
<td>3</td>
<td>ON</td>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
</tr>
</tbody>
</table>
+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+

ATF Sessions Monitored

+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+
| Type | ID | Status | Start Time | End Time | Filter | AS | Monitor Options | | | | | |
|------|----|--------|------------|----------|-------|----|-----------------| | | | | | |
| DCMN |I61R |R     |           |---------- |N/A    |N/A | x  | x  |x | x  | |
+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+
| DBMN |I61B |I     |03/19 09:50|03/20 09:50|N/A    |N/A | x  | -  |- | x  | |
+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+
| OMEG |IPOIS05 |A |03/30 12:50|---------- |005 |65M | x  | x  |x | x  | |
+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+
| OMEG |IPOIS06 |A |03/30 12:50|---------- |005 |65M | x  | x  |x | x  | |
+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+
| OMEG |IPOIS10 |A |03/30 12:55|---------- |066 |130M | x  | x  |x | x  | |
+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+-----------------------------+

F1=Help F2=Keys F3=Exit F5=Refresh F6=Console **=Bkwd  **=Fwd
F10=Action Bar F15=System Overview
**Note:** A DCMN session type is not shown for a DBCTL system. A DBMN session type is not shown for an IMS DB/DC or IMS DC system.

This panel displays the:
- Status of the ATF Manager
- Current startup parameters for the ATF Manager
- Status of the IMS or DBCTL Monitor
- Status of each connected ATF session

For each session, the following information is displayed:
- Type of session (DCMN, DBMN, and OMEGAMON)
- Session identification (IMSID and OMEGAMON Classic jobname)
- Startup parameters
- Size of the dataspace
- IMS Monitor settings

The session status indicates if the session is:
- A - Active
- I - Inactive
- R - Already active when the ATF Manager is started. This status only applies to IMS Monitor sessions. The start time is unknown.

It is possible for an OMEGAMON Classic session to be shown as inactive because the address space was terminated or the session was terminated.
Chapter overview

This section describes how to filter ATF data so that you can control the amount and type of data that is collected.

Chapter contents

How to Use ATF Filtering ............................................................. 48
ATF Usage Recommendations ..................................................... 49
How to Use ATF Filtering

Overview
ATF filtering focuses the collection of data and limits the amount of data collected and written to a dataspace. You can conserve system resources by qualifying the performance data you want to collect. You add filtering data in an ATF trace. Refer to “ATF Actions” on page 39 for more information.

ATF filter data
The ATF Manager filters information for the following keywords:
- Tran
- Userid
- Lterm
- Region ID
- PSB
- DB data (only valid for IMS V7.1 or higher)

Syntax for filtering data
An asterisk (*) in the last position accepts any number of characters to check against the target. A generic specification for filter data uses fewer CPU cycles than hundreds of specific ones.

However, when you use specific filters ATF edits and references the parameters. For example, if the PSB name is misspelled, ATF indicates that the PSB does not exist and asks for a correction. This is very helpful when setting filters to be activated at a future date and time.

In addition, ATF provides a default elapsed time to control runaway monitoring when a duration is not specified.
ATF Usage Recommendations

ATF and IMS Monitor Facility

You can use ATF to detect performance problems within IMS and DBCTL applications.

ATF internally activates the IMS Monitor Facility and uses its data for reporting. Even though ATF minimizes the impact of the IMS Monitor Facility, you need to understand the basic impact of the IMS Monitoring Facility.

Usage guidelines

General usage guidelines are:

- Be selective about the applications you monitor
- Monitor for short durations
- Use specific filter criteria for monitoring

ATF uses ECSA storage for the life of an ATF Manager session, but deletes this storage when stopped.
Transaction Data Displays

Chapter overview

The transaction data ATF collects is described in this chapter along with examples of the panels that display this information.

Chapter contents

Displaying ATF Data from OMEGAMON II ........................................ 52
Summary of Transaction Data ............................................................ 53
Trace Details ...................................................................................... 56
Event Timings .................................................................................... 60
Trace Event List ................................................................................ 62
Displaying ATF Data from OMEGAMON II

Overview
You can view transaction data collected by ATF from the GoTo pull-down on any OMEGAMON II panel. You can also add and modify traces and filter criteria by selecting ATF from the Options pull-down on any OMEGAMON II panel. See “ATF Actions” on page 35 for more information on ATF trace functions.

GoTo pull-down
To view ATF data:

- Select option 8 from the OMEGAMON II GoTo pull-down and press Enter.

or

- Type g.a in the input area of the action bar of any OMEGAMON II panel and press Enter.

The ATF Transaction History panel displays with a list of all of the monitored transactions for an ATF session.

Figure 7. ATF Transaction History panel

<table>
<thead>
<tr>
<th>UTC Time</th>
<th>Tran</th>
<th>PSB</th>
<th>Lterm/</th>
<th>Elapsed Time</th>
<th>Rgn</th>
</tr>
</thead>
<tbody>
<tr>
<td>15:45:15</td>
<td>DSPINV</td>
<td>DFSSAM03</td>
<td>RYATE</td>
<td>00:00:01.341.000</td>
<td>004</td>
</tr>
<tr>
<td>15:49:15</td>
<td>DSN8CS</td>
<td>DSN8ICO</td>
<td>RYATE</td>
<td>00:00:40.744.000</td>
<td>004</td>
</tr>
<tr>
<td>15:50:16</td>
<td>PART</td>
<td>DFSSAM02</td>
<td>GCAMA</td>
<td>00:00:02.231.000</td>
<td>004</td>
</tr>
<tr>
<td>15:50:16</td>
<td>PART</td>
<td>DFSSAM02</td>
<td>GCAMA</td>
<td>00:00:04.544.000</td>
<td>004</td>
</tr>
</tbody>
</table>

F1=Help F2=Keys F3=Exit F5=Refresh F6=Console **=Bkwd **=Fwd
F10=Action Bar F15=System Overview F16=ATF Status

52 IBM Tivoli OMEGAMON II for IMS Application Trace Facility, Version 5.5.0
Summary of Transaction Data

ATF Transaction History panel
The ATF Transaction History panel displays all of the transaction data that was collected by ATF. The transactions are listed by name and sorted by time sequence.

Field descriptions
The transactions that are traced are based on the filter criteria specified in the ATF trace.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UTC Time</td>
<td>The Universal Time Coordinate time that the data was collected</td>
</tr>
<tr>
<td>Tran Name</td>
<td>The name of the transaction that was traced</td>
</tr>
<tr>
<td>PSB Name</td>
<td>The name of the application program this transaction used</td>
</tr>
<tr>
<td>Lterm/Userid</td>
<td>The logical terminal that initiates the transaction, which in IMS/ETO systems, is usually synonymous with the userid</td>
</tr>
<tr>
<td>Database</td>
<td>The DB name, data entry DB name, or an HALDB partition name for this transaction. For versions prior to IMS/ESA V7, N/A is displayed in this field. Where there is no DB name supplied in the trace filter, and there is more than one database PCB in the PSB, the term 'MULTI_DB' is placed in this field. This applies only to IMS/ESA V7 or higher.</td>
</tr>
<tr>
<td>Elapsed Time</td>
<td>The amount of time for which the data was collected</td>
</tr>
<tr>
<td>Abend</td>
<td>For transactions that end abnormally, this is the abend code</td>
</tr>
<tr>
<td>Region ID</td>
<td>The IMS region identifier</td>
</tr>
</tbody>
</table>

Viewing data
You can display different information on the ATF Transaction History panel by selecting view options on the View pull-down. These options are:
- All data
- Some data
- Data positioned by date and time
**Viewing specific data**

To view specific data, select **Some** on the View pull-down and then, on the following panel, select the type of information you want to view, for example, **v2**.

*Figure 8. View pull-down*
Select **option 3** and press Enter to display another panel on which you type the filter criteria for Lterm/Userid.

**Figure 9. Filter Criteria for Lterm/Userid panel**

In this example, type **RYATE** for the Lterm/Userid. Press Enter to display the ATF Transaction History panel with information for this ID only. See the next panel.

**Figure 10. ATF Transaction History panel**
Trace Details

The Trace History Details panel displays an overview of an ATF trace. This information includes the date and time the trace began collecting data for a specific transaction, and the total amount of time that data was collected.

This panel is displayed when you type **S** in the command column for a transaction on the ATF Transaction History panel. Or, place the cursor next to the correct column on the ATF Transaction History panel and press Enter.

For example, the trace history details that are displayed for the transactions shown in Figure 10 on page 55 are shown on the following panels.

**Figure 11. Trace History Details for DSPINV**
Figure 12. Trace History Details for DSN8CS

<table>
<thead>
<tr>
<th>Actions</th>
<th>GoTo</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>--------------------------------------------------</td>
<td>------</td>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td><strong>Actions</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>GoTo</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>KI2PTA11</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Trace History Details</strong></td>
<td>I61R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+-----------------------------------------------------------------------------+------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transaction . . . . . : DSN8CS</td>
<td>_ PSB . . . . . . . : DSN8IC0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lterm . . . . . . : RYATE</td>
<td>_ Lterm . . . . . . : RYATE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Region type . . . . . : MPP</td>
<td>_ Region type . . . . . : MPP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Region ID . . . . . : 4</td>
<td>_ Region ID . . . . . : 4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Userid . . . . . . . : RYATE</td>
<td>_ Userid . . . . . . . : RYATE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total Trace Time : 00:00:40.741.000</td>
<td>Total CPU time : 00:00:00.321.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>UTC StartDate mm/dd/yyyy 03/28/2001</td>
<td>Current SPA size . . . : N/A</td>
<td></td>
</tr>
<tr>
<td></td>
<td>UTC StartTime hh:mm:ss.t 15:49:35.8</td>
<td>Abend code . . . . . . : 000000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LCL StartDate mm/dd/yyyy 03/28/2001</td>
<td>Job name . . . . . . . : IMS6RMS1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LCL StartTime hh:mm:ss.t 07:49:35.7</td>
<td>Step name . . . . . . . : REGION</td>
<td></td>
</tr>
<tr>
<td>+-----------------------------------------------------------------------------+------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(Details) <Timings> <Trace>
F1=Help  F2=Keys  F3=Exit  F5=Refresh  F6=Console  F10=Action Bar
F15=System Overview  F16=ATF Status
### Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction</td>
<td>The name of the transaction that was traced</td>
</tr>
<tr>
<td>Lterm</td>
<td>The logical terminal that initiated the transaction, which in IMS/ETO systems, is usually synonymous with the userid</td>
</tr>
<tr>
<td>Region type</td>
<td>The type of IMS region with values of: MPP - IMS message region IFP - IMS fast path region BMPNM - IMS batch message region, non-message driven BMPMD - IMS batch message region, message driven DBT - DB control connection region TRACK - Tracking region Other - Utility region</td>
</tr>
<tr>
<td>Region ID</td>
<td>The IMS message region ID</td>
</tr>
<tr>
<td>Userid</td>
<td>The userid that initiated the transaction, which in IMS/ETO systems, is usually synonymous with the logical terminal</td>
</tr>
<tr>
<td>Total trace time</td>
<td>The amount of time for which data was collected.</td>
</tr>
<tr>
<td>UTC StartDate</td>
<td>The Universal Time Coordinate month, day and year (mm/dd/yyyy) the trace began collecting data</td>
</tr>
<tr>
<td>UTC StartTime</td>
<td>The Universal Time Coordinate hour, minute, second and tenth of a second the trace began collecting data</td>
</tr>
<tr>
<td>LCL StartDate</td>
<td>The local computer date the trace began collecting data</td>
</tr>
<tr>
<td>LCL StartTime</td>
<td>The local computer time the trace began collecting data</td>
</tr>
<tr>
<td>PSB Name</td>
<td>The name of the application program that this transaction is using</td>
</tr>
<tr>
<td>Transaction class</td>
<td>The IMS class assigned to this transaction</td>
</tr>
<tr>
<td>Message source</td>
<td>The source of the input message. Possible values are: TERM - Standard terminal CPIC - CPIC-driven program APPC - LU6.2 source OTMA - OTMA source</td>
</tr>
<tr>
<td>Primed message</td>
<td>Indicator if the message is primed for the application program (YES) or not (NO)</td>
</tr>
</tbody>
</table>
Transaction Data Displays

**Trace Details**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick schedule</td>
<td>Indicator if IMS Quick scheduling is in effect (YES) or not (NO)</td>
</tr>
<tr>
<td>Total CPU time</td>
<td>The total CPU time for the trace. If the CPU time is less than one microsecond, then the phrase ‘&lt; 1 micro second’ is placed in this field.</td>
</tr>
<tr>
<td>Current SPA size</td>
<td>For IMS conversational transactions, the current SPA size. Otherwise, N/A is shown.</td>
</tr>
<tr>
<td>Abend code</td>
<td>For transactions that end abnormally, this is the abend code. Otherwise, all zeroes are shown.</td>
</tr>
<tr>
<td>Job name</td>
<td>The name of the IMS message region job</td>
</tr>
<tr>
<td>Step name</td>
<td>The name of the IMS message region step within the job</td>
</tr>
</tbody>
</table>

**Displaying field details**

To display more information about a specific field on the Trace History Details panel, type **s** in one of the following fields and press Enter:

- Transaction
- Lterm
- Userid
- PSB
- Transaction class

Another panel displays with the specific information for the field you selected.

**Displaying event timings**

To view the average and total amount of time that elapsed for all trace events, tab to the push button **Timings** and press Enter. The Trace Event Timings panel is displayed (see page 60).

**Displaying trace events**

To display all of the events for a transaction trace, tab to the **Trace** push button and press Enter. The Application Trace panel is displayed (see page 62).
Event Timings

Trace Event Timings panel

When you select Timings on an ATF panel, a summary of all the different events produced in an ATF trace is displayed. This information includes the total number of IMS Monitor records generated to report the contents of this trace. The following panels are examples of the trace event timings for the transactions shown in Figure 10 on page 55.

Figure 13. Trace Event Timings for DSPINV
### Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>The event that occurred while a transaction was monitored</td>
</tr>
<tr>
<td>Type</td>
<td>The IMS DLI or any external subsystem command code</td>
</tr>
<tr>
<td>Count</td>
<td>The number of events of this type that occurred</td>
</tr>
<tr>
<td>Total Elapsed Time</td>
<td>The total amount of time that elapsed for all events of this type</td>
</tr>
<tr>
<td>Average Elapsed Time</td>
<td>The average amount of time that elapsed for each event of this type</td>
</tr>
</tbody>
</table>

#### Figure 14. Trace Event Timings for DSN8CS

<table>
<thead>
<tr>
<th>Event</th>
<th>Type</th>
<th>Count</th>
<th>Total Elapsed Time (mm:ss.ttt.iii)</th>
<th>Average Elapsed Time (mm:ss.ttt.iii)</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMS TM</td>
<td>ASRT</td>
<td>1</td>
<td>00:00.037.022</td>
<td>00:00.037.022</td>
</tr>
<tr>
<td>ESS</td>
<td>CREATE THREAD</td>
<td>1</td>
<td>00:00.006.704</td>
<td>00:00.006.704</td>
</tr>
<tr>
<td>IMS TM</td>
<td>(GU)</td>
<td>1</td>
<td>00:00.000.197</td>
<td>00:00.000.197</td>
</tr>
<tr>
<td>IMS TM</td>
<td>ISRT</td>
<td>1</td>
<td>00:00.000.080</td>
<td>00:00.000.080</td>
</tr>
<tr>
<td>ESS</td>
<td>SIGNON</td>
<td>1</td>
<td>00:00.000.071</td>
<td>00:00.000.071</td>
</tr>
<tr>
<td>ESS</td>
<td>SNO</td>
<td>1</td>
<td>00:00.000.068</td>
<td>00:00.000.068</td>
</tr>
</tbody>
</table>
Trace Event List

Application Trace panel

When you select **Trace** on an ATF panel, a full event list is displayed on the Application Trace panel. This panel shows all activities of a transaction and the resulting IMS and external subsystem actions. For a better understanding of this information, refer to the following topic, Understanding the event list on the Application Trace panel. See Figure 15 on page 63 and Figure 16 on page 64 for the event lists for **DSPINV** and **DSN8CS**.

Understanding the event list on the Application Trace panel

To better understand the information shown on the Application Trace panel, please review the following tips:

- In some fields and columns >9999999 means that the value is greater than 99 seconds.
- In some fields and columns <1 micsec means that the value is less than one microsecond.
- Within the Level Column, level 1’s are not subordinate to level 0’s.
- Only level 2’s are subordinate to level 1’s.
- A level 3 is only subordinate to its level 2.
- The DL/I entry in the Event Description Column means that this time was spent editing and setting up a call in DL/I code (primarily DFSDLA00 or DFSDLA30).

The total of the event times in the Duration Column may not add up to the elapsed trace time. Other factors that may influence this time inconsistency are such events as:

- Application code execution time
- Waiting for CPU dispatching
- Events that are not measured by the IMS Monitor.
### Application Trace for DSPINV

**UTC Start Time**

<table>
<thead>
<tr>
<th>(hh:mm:ss.ttt)</th>
<th>Level</th>
<th>Duration (micsec)</th>
<th>Event Description</th>
<th>Resources</th>
<th>Verb</th>
<th>RC</th>
</tr>
</thead>
<tbody>
<tr>
<td>15:45:34.238</td>
<td>0</td>
<td>500</td>
<td>MPP SCHEDULING</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:34.738</td>
<td>0</td>
<td>0</td>
<td>DL/I CALL (TM)</td>
<td>RYATE</td>
<td>(GU)</td>
<td></td>
</tr>
<tr>
<td>15:45:35.520</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:35.632</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:35.635</td>
<td>0</td>
<td>430</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:35.721</td>
<td>2</td>
<td>37</td>
<td>VSAM CALL</td>
<td>DI21PART</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:35.759</td>
<td>2</td>
<td>12</td>
<td>VSAM CALL</td>
<td>DI21PART</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:35.771</td>
<td>2</td>
<td>8</td>
<td>VSAM CALL</td>
<td>DI21PART</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:35.779</td>
<td>2</td>
<td>42</td>
<td>VSAM CALL</td>
<td>DI21PART</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:35.823</td>
<td>2</td>
<td>1</td>
<td>VSAM CALL</td>
<td>DI21PART</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:35.987</td>
<td>2</td>
<td>32</td>
<td>VSAM CALL</td>
<td>DI21PARO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.032</td>
<td>2</td>
<td>2</td>
<td>VSAM CALL</td>
<td>DI21PARO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.041</td>
<td>2</td>
<td>2</td>
<td>VSAM CALL</td>
<td>DI21PART</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.066</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.066</td>
<td>1</td>
<td>0</td>
<td>DL/I CALL (DB)</td>
<td>DI21PART</td>
<td>GNP</td>
<td></td>
</tr>
<tr>
<td>15:45:36.067</td>
<td>2</td>
<td>1</td>
<td>VSAM CALL</td>
<td>DI21PARO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.067</td>
<td>1</td>
<td>1</td>
<td>DL/I CALL (DB)</td>
<td>DI21PART</td>
<td>CN</td>
<td></td>
</tr>
<tr>
<td>15:45:36.067</td>
<td>0</td>
<td>1</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.070</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.070</td>
<td>1</td>
<td>0</td>
<td>DL/I CALL (TM)</td>
<td>RYATE</td>
<td>ISRT</td>
<td></td>
</tr>
<tr>
<td>15:45:36.071</td>
<td>1</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.071</td>
<td>1</td>
<td>0</td>
<td>DL/I CALL (TM)</td>
<td>RYATE</td>
<td>ISRT</td>
<td></td>
</tr>
<tr>
<td>15:45:36.072</td>
<td>1</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.072</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.072</td>
<td>0</td>
<td>0</td>
<td>DL/I CALL (TM)</td>
<td>RYATE</td>
<td>ISRT</td>
<td></td>
</tr>
<tr>
<td>15:45:36.072</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.073</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.073</td>
<td>1</td>
<td>0</td>
<td>DL/I CALL (TM)</td>
<td>RYATE</td>
<td>ISRT</td>
<td></td>
</tr>
<tr>
<td>15:45:36.073</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.073</td>
<td>1</td>
<td>0</td>
<td>DL/I CALL (TM)</td>
<td>RYATE</td>
<td>ISRT</td>
<td></td>
</tr>
<tr>
<td>15:45:36.074</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.075</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.075</td>
<td>1</td>
<td>0</td>
<td>DL/I CALL (DB)</td>
<td>DI21PART</td>
<td>GNP</td>
<td>GE</td>
</tr>
<tr>
<td>15:45:36.075</td>
<td>1</td>
<td>0</td>
<td>DL/I CALL (TM)</td>
<td>RYATE</td>
<td>ISRT</td>
<td></td>
</tr>
<tr>
<td>15:45:36.075</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.077</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.077</td>
<td>1</td>
<td>0</td>
<td>DL/I CALL (DB)</td>
<td>DI21PART</td>
<td>STAT</td>
<td></td>
</tr>
<tr>
<td>15:45:36.077</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.077</td>
<td>1</td>
<td>0</td>
<td>DL/I CALL (DB)</td>
<td>DI21PART</td>
<td>STAT</td>
<td></td>
</tr>
<tr>
<td>15:45:36.078</td>
<td>1</td>
<td>0</td>
<td>DL/I CALL (DB)</td>
<td>DI21PART</td>
<td>STAT</td>
<td>GE</td>
</tr>
<tr>
<td>15:45:36.078</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.078</td>
<td>1</td>
<td>0</td>
<td>DL/I CALL (TM)</td>
<td>RYATE</td>
<td>ASRT</td>
<td></td>
</tr>
<tr>
<td>15:45:36.078</td>
<td>0</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:45:36.079</td>
<td>0</td>
<td>0</td>
<td>MPP TERM THREAD</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction</td>
<td>The name of the transaction that was monitored</td>
</tr>
<tr>
<td>PSB</td>
<td>The name of the application program this transaction used</td>
</tr>
<tr>
<td>UTC Offset</td>
<td>The Universal Time Coordinate offset, which when factored with the UTC time, results in local computer time</td>
</tr>
<tr>
<td>UTC Start Time</td>
<td>The Universal Time Coordinate hour, minute, second and millisecond the trace began collecting data</td>
</tr>
<tr>
<td>Level</td>
<td>The IMS depth of the event, shown in descending order</td>
</tr>
<tr>
<td>Duration</td>
<td>The duration of this event in microseconds</td>
</tr>
<tr>
<td>Event Description</td>
<td>A description of the event that was monitored</td>
</tr>
<tr>
<td>Resources</td>
<td>The resource used by this event</td>
</tr>
<tr>
<td>Func Verb</td>
<td>The IMS or external subsystem function that was issued</td>
</tr>
<tr>
<td>RC</td>
<td>The return code issued when the IMS or external subsystem function was executed</td>
</tr>
</tbody>
</table>

#### Data Table

<table>
<thead>
<tr>
<th>UTC Start Time</th>
<th>Duration</th>
<th>Event Description</th>
<th>Resources</th>
<th>Func Verb</th>
<th>RC</th>
</tr>
</thead>
<tbody>
<tr>
<td>15:48:55.146</td>
<td>40382</td>
<td>MPP SCHEDULING</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:49:35.528</td>
<td>0</td>
<td>DL/I CALL (TM)</td>
<td>RYATE</td>
<td>GU</td>
<td></td>
</tr>
<tr>
<td>15:49:35.776</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:49:35.777</td>
<td>0</td>
<td>ESS SIGNON</td>
<td>D61D</td>
<td>00</td>
<td></td>
</tr>
<tr>
<td>15:49:35.777</td>
<td>0</td>
<td>ESS CREATE THRD</td>
<td>D61D</td>
<td>04</td>
<td></td>
</tr>
<tr>
<td>15:49:35.783</td>
<td>0</td>
<td>ESS SNO</td>
<td>D61D</td>
<td>04</td>
<td></td>
</tr>
<tr>
<td>15:49:35.849</td>
<td>37</td>
<td>DL/I CALL (TM)</td>
<td>RYATE</td>
<td>ISRT</td>
<td></td>
</tr>
<tr>
<td>15:49:35.849</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:49:35.852</td>
<td>37</td>
<td>DL/I CALL (TM)</td>
<td>RYATE</td>
<td>ASRT</td>
<td></td>
</tr>
<tr>
<td>15:49:35.852</td>
<td>0</td>
<td>DL/I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15:49:35.890</td>
<td>0</td>
<td>MPP TERM THREAD</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
If you have a problem with your IBM software, you want to resolve it quickly. This section describes the following options for obtaining support for IBM software products:

- “Searching knowledge bases” on page 65
- “Obtaining fixes” on page 66
- “Receiving weekly support updates” on page 66
- “Contacting IBM Software Support” on page 67

**Searching knowledge bases**

You can search the available knowledge bases to determine whether your problem was already encountered and is already documented.

**Searching the information center**

IBM provides extensive documentation that can be installed on your local computer or on an intranet server. You can use the search function of this information center to query conceptual information, instructions for completing tasks, and reference information.

**Searching the Internet**

If you cannot find an answer to your question in the information center, search the Internet for the latest, most complete information that might help you resolve your problem.

To search multiple Internet resources for your product, use the Web search topic in your information center. In the navigation frame, click Troubleshooting and support > Searching knowledge bases and select Web search. From this topic, you can search a variety of resources, including the following:

- IBM technotes
- IBM downloads
- IBM Redbooks®
- IBM developerWorks®
- Forums and newsgroups
- Google
Obtaining fixes

A product fix might be available to resolve your problem. To determine what fixes are available for your IBM software product, follow these steps:

2. Click Downloads and drivers in the Support topics section.
3. Select the Software category.
4. Select a product in the Sub-category list.
5. In the Find downloads and drivers by product section, select one software category from the Category list.
6. Select one product from the Sub-category list.
7. Type more search terms in the Search within results if you want to refine your search.
8. Click Search.
9. From the list of downloads returned by your search, click the name of a fix to read the description of the fix and to optionally download the fix.

For more information about the types of fixes that are available, refer to the IBM Software Support Handbook at http://techsupport.services.ibm.com/guides/handbook.html.

Receiving weekly support updates

To receive weekly e-mail notifications about fixes and other software support news, follow these steps:

2. Click My Support in the upper right corner of the page.
3. If you have already registered for My Support, sign in and skip to the next step. If you have not registered, click register now. Complete the registration form using your e-mail address as your IBM ID and click Submit.
4. Click Edit Profile.
5. In the Products list, select Software. A second list is displayed.
6. In the second list, select a product segment, for example, Application servers. A third list is displayed.
7. In the third list, select a product sub-segment, for example, Distributed Application & Web Servers. A list of applicable products is displayed.
8. Select the products for which you want to receive updates, for example, IBM HTTP Server and WebSphere Application Server.
9. Click Add products.
10. After selecting all products that are of interest to you, click Subscribe to email on the Edit profile tab.
11. Select Please send these documents by weekly email.
12. Update your e-mail address as needed.

13. In the Documents list, select Software.

14. Select the types of documents that you want to receive information about.

15. Click Update.

If you experience problems with the My support feature, you can obtain help in one of the following ways:

Online: Send an e-mail message to erchelp@ca.ibm.com, describing your problem.

By phone: Call 1-800-IBM-4You (1-800-426-4968).

Contacting IBM Software Support

IBM Software Support provides assistance with product defects.

Before contacting IBM Software Support, your company must have an active IBM software maintenance contract, and you must be authorized to submit problems to IBM. The type of software maintenance contract that you need depends on the type of product you have:

- For IBM distributed software products (including, but not limited to, Tivoli, Lotus®, and Rational® products, as well as DB2® and WebSphere® products that run on Windows or UNIX operating systems), enroll in Passport Advantage® in one of the following ways:
  - Online: Go to the Passport Advantage Web page (http://www.lotus.com/services/passport.nsf/WebDocs/Passport_Advantage_Home) and click How to Enroll
  - By phone: For the phone number to call in your country, go to the IBM Software Support Web site at http://techsupport.services.ibm.com/guides/contacts.html and click the name of your geographic region.

- For customers with Subscription and Support (S & S) contracts, go to the Software Service Request Web site at https://techsupport.services.ibm.com/ssr/login.


- For IBM eServer™ software products (including, but not limited to, DB2 and WebSphere products that run in zSeries, pSeries, and iSeries environments), you can purchase a software maintenance agreement by working directly with an IBM sales representative or an IBM Business Partner. For more information about support for eServer software products, go to the IBM Technical Support Advantage Web site at http://www.ibm.com/servers/eserver/techsupport.html.

If you are not sure what type of software maintenance contract you need, call 1-800-IBMSERV (1-800-426-7378) in the United States. From other countries, go to the contacts page of the IBM Software Support Handbook on the Web at
To contact IBM Software Support, follow these steps:

1. “Determining the business impact” on page 68
2. “Describing problems and gathering information” on page 68
3. “Submitting problems” on page 69

Determining the business impact

When you report a problem to IBM, you are asked to supply a severity level. Therefore, you need to understand and assess the business impact of the problem that you are reporting. Use the following criteria:

<table>
<thead>
<tr>
<th>Severity 1</th>
<th>The problem has a critical business impact. You are unable to use the program, resulting in a critical impact on operations. This condition requires an immediate solution.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Severity 2</td>
<td>The problem has a significant business impact. The program is usable, but it is severely limited.</td>
</tr>
<tr>
<td>Severity 3</td>
<td>The problem has some business impact. The program is usable, but less significant features (not critical to operations) are unavailable.</td>
</tr>
<tr>
<td>Severity 4</td>
<td>The problem has minimal business impact. The problem causes little impact on operations, or a reasonable circumvention to the problem was implemented.</td>
</tr>
</tbody>
</table>

Describing problems and gathering information

When explaining a problem to IBM, be as specific as possible. Include all relevant background information so that IBM Software Support specialists can help you solve the problem efficiently. To save time, know the answers to these questions:

- What software versions were you running when the problem occurred?
- Do you have logs, traces, and messages that are related to the problem symptoms? IBM Software Support is likely to ask for this information.
- Can you re-create the problem? If so, what steps were performed to re-create the problem?
- Did you make any changes to the system? For example, did you make changes to the hardware, operating system, networking software, and so on.
- Are you currently using a workaround for the problem? If so, be prepared to explain the workaround when you report the problem.
- What software versions were you running when the problem occurred?
Submitting problems

You can submit your problem to IBM Software Support in one of two ways:

- **Online:** Click **Submit and track problems** on the IBM Software Support site at [http://www.ibm.com/software/support/probsub.html](http://www.ibm.com/software/support/probsub.html). Type your information into the appropriate problem submission form.

- **By phone:** For the phone number to call in your country, go to the contacts page of the IBM Software Support Handbook ([http://techsupport.services.ibm.com/guides/contacts.html](http://techsupport.services.ibm.com/guides/contacts.html)) and click the name of your geographic region.

If the problem you submit is for a software defect or for missing or inaccurate documentation, IBM Software Support creates an Authorized Program Analysis Report (APAR). The APAR describes the problem in detail. Whenever possible, IBM Software Support provides a workaround that you can implement until the APAR is resolved and a fix is delivered. IBM publishes resolved APARs on the Software Support Web site daily, so that other users who experience the same problem can benefit from the same resolution.
Overview

This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in
new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX  78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurement may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any
similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM’s application programming interfaces.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights reserved.

If you are viewing this information in softcopy form, the photographs and color illustrations might not display.

Trademarks

IBM, the IBM logo, AIX, DB2, developerWorks, eServer, IBMLink, Informix, iSeries, Lotus, Passport Advantage, pSeries, Rational, Redbooks, S/390, Tivoli, the Tivoli logo, Tivoli Enterprise Console, TME, WebSphere, and zSeries are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both.

Intel, Intel Inside (logos), MMX, Celeron, Intel Centrino, Intel Xeon, Itanium, Pentium and Pentium III Xeon are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.
Other company, product, and service names may be trademarks or service marks of others.
activate a trace 40
active status 46
add a trace 39
Add Trace panel 39
administrative functions 43
Already active status 46
Application Trace Control panel 37
Application Trace Facility (ATF) see ATF 18
Application Trace Facility Status panel 45
Application Trace panel 62
ATF 35, 43, 47
components 19
control flow 19
data flow 19
definition 18
displaying data 20
end session 32
environments 24
how it works 20
impact on system performance 25
IMS functions 40
in a shared queue environment 25
installation 26
multiple sessions 20
OMEGAMON II 18
operating requirements 24
purpose 18
security 26
selecting an action 39
startup and shutdown commands 27
status 45
system requirements 24
traces (see also traces) 20
types of data 18
usage recommendations 49
ATF Collector 19
ATF Manager 19, 28, 30
ATF Transaction History panel 53, 56
ATFACT keyword 32
ATFDBC keyword 29
ATFDBM keyword 29
ATFDCM keyword 29
ATFNUM keyword 29
ATFTRAC keyword 29

books
see publications 10, 13

clear trace data 44
clearing a dataspace 44
collect data 39
command security exit 26
commands
Shutdown 30, 31, 32
Startup 29
components of ATF 19
control flow of ATF 19
cursor option, set 41
customer support
see Software Support 67
data
and traces 39
filter 47
types collected by ATF 18
viewing 53
data flow in ATF 19
dataspace 19
clearing 44
default size 20
definition 44
deleting 44
size 32
delete a trace 40
deleting a dataspace 44
deleting trace data 44
DFSCCMD0 command security exit 26
displaying
ATF data from OMEGAMON II 52
data 51
event timings 59
field details 59
trace events 59
documentation conventions 15
duration of a trace 39

E
E-MCS environment and security 26
display overview  56
duration  39
Event List  62
events  59
filter data  48
functions  36
managing  36
modify  40
number of minutes  32
transaction data displays  51
Transaction Reporting Facility (TRF)  18
TRF (Transaction Reporting Facility)  18
usage recommendations for ATF  49
view transaction data  21
viewing data  53
viewing the ATF status  45